OnCall

Physician Scheduling

_\Q N
H Printing Schedules

Website: www.amion.com

Contacts

Stuart Karon Carol Philips Cumming
Founder Marketing Director

Vermont Office Maryland Office

Product Development, Support, Licensing, Sales, Implementation,
Training Support, Training

Email: stuart@amion.com Email: carol@amion.com

Tel: 802.649.1911 Tel: 301.767.1675

OnCall's printing feature offers many options and flexibility for printing schedules and tables
either directly from the OnCall software or from the Amion.com website. This guide will
review each of the options for printing as well as provide examples of how formatting can
enhance and customize the look of your printed schedules.

OnCall Software Printing Options:

Once your call schedule is complete, you may need to print the most current week, month or
year. There are a few basic formatting functions that are necessary to customize before printing
the schedule.

I. Schedule Content*: .

Figure 1 — Schedule Content Box
Each schedule includes a great deal of
information that you may or may not want
included in the printout. Or, you might find that *|abor
there is too much information to fit on one page. STNC
The Schedule Content feature allows you to
choose which rows of a schedule to display or
hide. To activate the Schedule Content feature,

click on the | icon in the toolbar. You will
notice the box to the right appear (figure 1).
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Along the top of the Content box, there are 8 buttons made up of 4 blue and 4 black
dots+ ¢ &< + 2t &4 They represent 8 pages or subsets that you can configure. Each page you
customize displays a subset of the full schedule. The page sets at amion.com are based on the
pages you configure in the Content box.

Select Setup #1, the first single blue dot. This will be the default content display for the online
schedules. It includes all of the services. Then click on Setup #2 (the double blue circle). You
will notice that all the services reappear in the list. Click on the call services until you have the
group of services you would like included in subset 2.

Hint: Remember to keep saving the file as you work through customizing your
settings.

If you want all services to be displayed as the default, leave Setup #1 showing everything and
configure the other page setups for your other services. The table and calendar formats have
their own page content setups. If you want the same groupings for calendar and table format,
switch the call schedule from calendar to table view and go through the same steps with the
Content box.

In the first example below (figure 2), the setup content box for subset 1 includes all services.
Likewise, the Calendar schedule also includes all services. If you were to print this schedule now,
it would include all services available. Once saved and published, this view will also be an option
for users to select at Amion.com.

In the next example (figure 3), the Setup Content subset 2 only includes two services, Labor Day
and Labor Night. This configuration has been set using the 2" subset (two blue dots). Every
time you need to print or view just those services, you would select the two blue dots in
Schedule Content.

Figure 2 — Setup #1 Example Figure 3 — Setup #2 Example
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Il. Set Day Range View Span

In addition to selecting which services to be displayed_ in the calendar or table view, you can also
select which time range to be included. Click on the icon at the in the toolbar. Or, you can
select “View Span Settings” within the Window menu. The below box will appear (figure 4).

Figure 4 — View and Tally by....

Yiew &Tally by... . i .

The default calendar and table view in OnCall is the full calendar
month. However, you may just want to view or print a week or
—- two week span (figure 5). In addition, you can select the setup
Shift star dete by [Idays <] view to be all views, Amion.com Calendar, Amion.com Table,
OnCall Calendar or OnCall Table.
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Figure 5 — Sunday through Saturday View

' Hours  Month
 shits ¥ & 7Days

Shift start date by -

Setup view: I Al wiews - v|
0 0
i< F} L] J+—+I - k F}

Printing in OnCall and Amion.com 3
Created by Spiral Software — Updated January 2008

Technical Support: 802.649.1911 Email Support: oncall@spiralsoftware.com



I1l1. Customize Titles

You can customize the title of any schedule or view, including subset views, in OnCall. Custom
titles created in OnCall will appear at amion.com once published. Once you customize a title,
amion.com uses the first 15 or 20 characters to label the page in the drop-down selector that lets
people choose which page to display.

Open your schedule in OnCall and select the subset within the schedule content box page you
want to title. Above the schedule and below the main toolbar, you should see the default title
(figure 6). If you don't, go to the View menu and turn on Page title onscreen. Once saved and
published, the title will also appear at Amion.com (figure 7).

Click on the title to customize it. When editing, note that the dates appear as %1, %2 and %y.
You should use these date macros in your new title as though they are real dates. Hit Enter or
click outside the title area when you've finished editing, and OnCall will replace the date macros
with information from the current schedule. Here's a list of all the available date macros:

%1 Begin date of the schedule

%2 End date of the schedule

%y Year

%m Month name (January, February, etc.)

%r Rotation / block # (only applies to resident schedules)

If you edit a title and later want to return to the default, click on the text and delete every
character. Hit Enter and OnCall restores the default title to the page.

Figure 6 — Customized Title in OnCall Figure 7 — How Title Appears at Amion.com
Fie Edit Wiew Options Reports ‘Window Help
s o R -
n##z  *izos ol o R D e i I LA | Set2 ¥||-Hilite - ] amion
LA Labar Day and Labar Night, 1/1 to 1/31, 2008
Sun #hon Tue Wed Thu Fri Sat R
I I 1 New year |2 B 4 5
labar day Kerng Anderson, £ Smith, K Jones, R Jacksan, P ]
labar night, Larson, A Kendall, L Larsan, 4| Gallagher, 4 Smith, K Labor Da‘;r and Labor ..\ lght, 1.!"1 to 1 .I'J3 1, 2008
= 1 New vear (2 We 3 Th 4 Fr 3 Sa
b Jonvary |7 o= ’ 10 L] |22 — = o
Jabar day Kendall, L Larson e 5 = & kendall, L Larson, A Kerns, Anderson, E (Smith, K Jones R Jackson, P
= E +1 & +1a
M e EDR e labornight Larson, A |[Kendall, L |[Lamson. A |Gallagher, A|Smith K
o 6 January |7 Mo 8 Tu 9 We 10 T 11 Fr 12 Sa
17 ” THE m labor d Kendall, L |Larson, A |Gallagher, AKermns, Jackson, P [Kendall, L |Laron, A
Jabar day | Gallagher, 4 Ker nderson, E|  Kendall, L ht | Jones, R Anderson, E |Smith, K Jones, R Smith, K Jones, R Kendall, L
Jabar night | Anderson, E Larsol Kerns, Larson, A =
13 Su 14 Mo 15 Tu 16 We 17 Th 18 F+X> 19 52
Gallagher, A|Kems, Jackson, P |[Smith, K Jones, R Anderson, E [Eendall, L
20 [ZTAMLK oy B £ = B 2¢ ght |Anderson, E [Larson, A [Kendall,L |Kerns, Jackson, P |Kems, Larson, A
Jabar day Kerns, Jacksan, P Larson, A| Gallagher, A|  Anderson, E| Gallagher, A Janes, R 5 a — 5 5 5
Jabar night | Gallagher, A Smith, K| Anderson, E[  Tackson,F|  Kendall, L| Anderson, [  Jacksan, F 20 Su 21 MLE day 22 Tu 23 We 24 Th 25 Fr 26 Sa
Kems, Jackson, P |Larson, A  |Gallagher. AlAnderson, E |Gallagher, A|Jones R
ht |Gallagher, A|Smith, K Anderson E |Jackson, P [Eendall I |Anderson, E |Jackson, P
27 22 29 20 P o S - .
fabar day Smith, K Kendall, L| Anderson, E Larson, A Gallagher, 4 27 Su 28 Mo 29 Tu 30 We 31 Ik
Jabar night Kerns, Junes, R Gallagher, A Smith, K Kerns, Smith, K Eendall, L |Andesson, E |Larson, A |Gallagher, A
ht |Kems, Tones, R Gallagher, A|Smith K Kermns,
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IV. Change Font Style and Text Size

The font style and text size can be customized for calendar or table views. Once you change the
font and/or text size it will change for all views. The font style and text size you select will also
be represented in the printouts. However, they will not be displayed at amion.com, rather a
standard font style and size will be displayed.

Within the “Window” Menu, select “Font”. Below are two examples of different font types
selected for both Calendar and Table formats (figures 8 and 9).

Figure 8 — Font Style Change to Comic Sans MS
mElgr [ *ir0ae | O|H

o ed #hain Title, 141 to 1731, 2008
Sun Mon Tue Wed Thu Fri Sat
I [ 1 New year |2 ] 4 5

Jay Kerns, | Anderson, E Smith, K Jones, R|  Jackson, P
it Larson, 4 Kendall, L Larson, A| Zallagher, A Smith, K
|C‘2"“i05@"1S M3 = = |TM kKendall, L|  Jackson, P Kerns Larsan, 4| Andersan, E
ELR Jackson, P Jones, B Jones, R|  Anderszon, E Kerns,

& Janvary 7 F g 18 FF 12
fabar day Kendall, L Larson, Al Gallagher, A Kerns Tacksan, P Kendall, L Larsan, A
labar night Jones, R|  Anderson, E Smith, K Jones, R Smith, K Jones, R Kendall, L
ThC Jackson, P Kendall, L|  Anderson, E| Gallagher, A Larson, A Kerns Smith, K
ELR Smith, K Kerns, Larson, A Jackson, P Kendall, L| Gallagher, 4| Gallagher, A

FES 14 15 Ers 17 FE3 19
fabar day | Gallagher, 4 Kerns Jackson, P Smith, K Jones, R|  Anderson, E Kendall, L
Jabar nigit | Andersan, E Larson, & Kendall, L Kerns, Jackson, P Kerns, Larsan, A
T Jones, R Jaones, B Smith, K[ Anderson, E| Gallagher, A Smith, K Jaones, Bt
ELR Jackson, P Kendall, L] Gallagher, A Larson, 4| Anderson, E Larson, & Smith, K

Figure 9 — In Table Format

Call Schedule, 1/1 to 1/31, 2008

-1 -2 1-3 1-4 1-B -8 -7 1-8 =g L0 | -1 | 112 | 1-13 | -4 | 116 | 1-16 | 1-17 | 1-18 | -9 | A0 | 1-2) | 1-22 | 1-23 | 1-24 | 1-2B | 1-26 | 1-2

labor day| =" | EA | KS | RT [PT | LK | AL | AG FT | LK | AL | AG PT [ K5 |RT | E4 | LK PT | AL | AG | EA | AG | RT | K5
abor nighT AL | LK | AL | AG | KS |RT |EA | KS [RT | KS [ RT | LK [EA | AL | LK PI AL [ AZ | KS | EA | PT | LK | EA | PT
THEC LK | P.T AL |EA | PT | LE | EA | AG | AL KS|RI|RIT | K5 |EA|AS |KS |RIT|PT | LK |RT kS | PT [ AL | AG
ELR PT |RI | RT | EA Ks AL | PT | LK | AG | AS | PT | LK | AG | AL | EA | AL | KS | EA K5 | LK K5 | LK | R
Kim i

.. Figure 10 — Printing Options
V. Printing Calendars and Tables from OncCall

Preferences E]

ﬁg:gg ggﬁ;‘?}-‘fs Printing Options
General Preferences: Once you have customized your Aon Fagg

. . Lmion Requests v Gray shade altemating lines
schedule or table, you are ready to print. OnCall has a series s [N
. . . . . . all schedulin v Piint service footnotes

of printing options available in the “Preferences” option found N
within the “File” Menu (figure 10). The printing options B s A TR e P ]

[ Mo time stamp it uppereft

include (1) Gray Shading for Alternative Lines, (2) Print
Service Footnotes, (3) Print Post-1t-Notes below Schedule, and

(4) Time Stamp. Select that options that apply and click “OK”.
Cancel
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Print Preview: Before you print, click on “Print Preview” within the File Menu. Here, you can
Enlarge or Shrink the size of your schedule or table. Below is an example of the difference in
appearances between a “shrunken” view (figure 11) versus one that was “enlarged” (figure 12).
The examples will print exactly as they are seen on the screen.

Figure 11 — Shrunk Print View Figure 12 — Enlarged Print View

Close  Print  Zoomin... shrink  EMLARGE Reset scale

Tn 181338 2008

ALL SERVICES, 1/1 to 1/31, 2008

Sun Jaon Tue Wed Thu Fri Sat
[t New year |2 P} 4 G
Iabor day | Kerns, | Anderson.E|  Swith. k| Tones. Rl  Jackson.
Iabor night Larson, 4 Kendall Ll Larson, Al Gallagher, A Smith, K
mae | Kendall L] Jackson, P Kerns, Larson, 4| Anderson, E
ALL SERVICES, U110 L31, 2008 £0R | Jackson, P Jones, R Jones, B| Andarson E Kenns,
[6 Janvary |7 B ] 10 11 12
f e ! ’ ! Iabara’ay! Kendall, L Larson, 41 Gallagher. A Kems, Jacksan, P Kendall, L Larson, A
‘ ‘ | ‘ ‘ Izbornight Jones, R| Arderson, E Smith, K Jones, R Smith, K] Jones. R Kendall L
| 3 1 1 ) ™NE ! Jackzon, P Kendall, L! Anderson. E! Ballagher, A Larson, A Kernz, ! Smith, K|
} - } } .}« } } } EOR Smith, K Kerns, Larson, A Jackzon, P Kendall L| Ballagher. A Gallagher. A
! | ! | [ e 17 14 15 16 17 15 19
I —t ——t——t——t— lborday | Gallagher. A Kerns, | Jackson.P|  Smith, K| Jones.R| Anderson.E|  Kendall. L
! ! ! | | | e ibornight  Anderson E|  Larson, A Kendall, L Kems, | Jackson, P Kerns, Larson, A
| | | (— | | TME| Jones, R Jones, | Smith, K| Anderson, E| Gallagher, 4 Smith, k| Tones, R
I et 't, | | | £0R Jackson, P Kendall L Ballagher. A Larsan, A| Anderson, E Larsan, A Smith, K|
1 . 1 1 - 1 1 1 1 20 21 MIK day |22 23 24 25 26
I ) i . ) } laborday Kems, | Jackson. P|  Larson, 4| Gallagher, 4| Andenson, E| Ballagher, 4 Jones, R
} }-’f } }-’4 } lehornight  Gallaghen, A Smith. K Anderson, E Jack=on, P Kendall, LI Anderson, E Jacksan, P
‘ " ‘ . ‘ | Jackson Pl Kendall, L] Jones, B Kems, Smith, K| Jackson, Pl Larson 4
‘ 5 ‘ ‘ ‘ EoR  Arderson, E Kerns, Smith. K Kendall L Kerns, Smith, KI Kendall, L|
27 28 29 20 a1
idhor day Smith, K Kendall L| Anderson, El Larsan. Al Gallaghen. A
lbarnight Kems, Jones, R Gallaghen, A Smith, K| Kz pns,
TNE | Gallagher, Al Anderson. E|  Jackson, P Kendall. L| TJores. R

EOR Jones, R Larson, A Kernz,  Gallagher, A Jackson, P
| 1 1

labornight  6:00 pm - 7:30am

Each page calendar or table needs to be printed separately. So, if you have 3 months of
schedules to print, you will need to print the first month, second month and third month
separately.

V. Printing Calendars and Tables from Amion.com

As with OnCall, there are a number of different options for printing online schedules at
Amion.com. Before printing, the user can select (1) calendar or table view, (2) the subset or
services to view, (3) name to highlight and (4) the font size. Below is the Amion.com toolbar
that the formatting options (figure 13). Any of the options can be printed (i.e. table, calendar,
subsets, who'’s on call, month, etc.).

Figure 13 — Amion.com Toolbar

o S AR e T LA Set? ~ || - Hilite ¥ | amion

2007 Jan Feb Mar Apr May June July Aug g 2008
- All rows —
Set4: THC
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Figure 14 — Subset 1

P
B S BB e e I HAA [Set ¥||~Hiite~ | amion
2007 Jan Feb Mar Apr Mav June Julv Aug Seot Oct Nov Dec 2008 Z00C
ALL SERVICES, 1/1 to 1/31, 2008

1 New year 2 We 3 Th d Fr 5 Sa

labor day Kems, Anderzon, E [Smith, K Jones. R Jackson, P
labornight Larson, A |[Kendall. 1 |Larson. A  |Gallagher, A|Smith, K
NG Kendall, L Jackson, P |Kems Larson. A |Anderson E
EDR Jackson P |Jones R Jones R \Anderson. E Kems,

6 January |7 Mo & Tu 5 We 10 Th ii Fr 12 Sa
laborday EKendall, L |Lamon, A Gallagher, A Kermns, Jackson. P [Kendall L |Lamon, A
labornight Jones, R Anderson, E Smith, K Jones,R Smith, K Jones. R Kendall. L
NG Jackson, P |[Kendall, L Anderson, E (Gallagher, AlLarson. A |Kems, Smith, K
EDR Smith, K |Kems Lason, A |Jackson, P |Kendall, L |Gallagher, AGallagher, A

13 3u 14 Mo 15 Tu 16 We 17 Th 18 Fr 19 Sa
labor day  |Gallagher, A[Kems Jackson, P |Smith, K Jones, R Anderson. E Kendall. L
labornight |Anderson, E |Larson, A Kendall, L [Kems, Jackson. P |[Eems, Larson, A
INC Jones R Jones R Smith, K Anderson, E |Gallagher, A|Smith, K Jones. R
EDR Jackson. P [Kendall. L Gallagher, AlLason, A |Andesson E [Lamon, A [Smith K

20 Su 21 MI.E'dayQ 22 Tu 23 We 24 Th 23 Fr 26 Sa
laborday |Kens, Jackson, P Larson, A |Gallagher, A|Anderson. E |Gallaghker, AlJones, R
labor night (Gallagher, A[Smith, K Anderson, E Jackson, P [Kendall,L |Anderson. E |Jackson,P
NG Jackson. P |Kendall. L Jones. R Kems, Smith. K Jackson. P |Larson. A
EDR Anderson, E (Kems Smith, K Eendall, L [Kems Smith, K Kendall, L

27 Su 28 Mo 20 Tu 30 We 31 Th
labor day |Smith, K Kendall, L Andesson E Lason, A |Gallagher, A
labor night Kems, Jones. R Gallagher, A|Smith, K Kems

In the example to the left (figure 14), Subset
#1 was selected (which includes all services).

In the below example left (figure 15), Subset #2 was selected (which includes 2 services), and a
name was highlighted (R. Jones). In addition, the font size was reduced. In the below example
right (figure 16), the schedule for K. Smith in January was selected. Each of these options can

be pr

inted.

Figure 15 — Subset 2

Figure 16 — Schedule for Individual

I @S- mY EUAA [Set2 v][JonesR ¥ amion | || # AL @S+ A amion
7 Jan Feb Mar Apr Mav June Julv Aug Sept Oct Nov Dec 2008 00 2007 Jan Feb Mar Apr May June July Aug Sept Oct Now Dec 2008 002
abor Day and Labor Night, 1/1 to 1/31, 2008 Schedule for Smith, K, January 2008
S R B oo F F 5 |30 December |31 Mo |z vewyear [z we |3 m 4 Fr 5 Sa
Eerns, Anderson E [Smith, K Jonss BRI Teckson, 7 lzbor day labor night
Lerson, A |(Eendall L  |Lamon, 4  |Gallagher, A|Smith K . b
& January |7 Mo & Tu 9 We 10 Th i1 Fr 12 5a 6 Janmuary 7 Mo 8 Tu 9 We 10 Th 11 Er 12 Sa
Eendall L |Lamon, 4 Gallagher, & |Eerns, Jackson, P |Eendall I |Lemon, &
Anderson, B [Smith, K JORGSNRIN Smith, K |Jonesp RO Kencall, L EDR labor night labor night TNC
13 Su 14 Mo 15 Tu 16 We |17 Th 18 Fr 19 5a
Gallezher, A|Kerns, Takson, P |Smith K Jomes, B |Ancerson, E [Kendll L 13 5u 14 Mo 15 Tu 16 We |17 Th |18 Fr 19 Sz
Anderson, E |Lamson, A Eendall L |Eerns, Jacksan P |Eerns, Larson, A ™~C labordaj.' ™ne EDR
20 Su gjm‘gﬂy¢22 Tu 23 We 24 Th 25 Fr 26 5a
Eerns, .Ta.c].-:sen,P L@en, A |Gallagher, & .J_u‘.ce.ncn,E Gsl}agher, .-\_ 20 Su 21 MLEday¢ 22 Tu 21 We 24 Th 25 Er 26 Sa
Gallagher, A Smmith K Anderson, E |Tackson, P |EKendzll L |Anderon, E (Tackson, P
27 Su 28 Mo 29 Tu 30 We 31 Th labor night EDR TNC EDR
Soith, K Eendall L Andersen E (Lamon, A |Gallagher, &
Kers,  Jones, B Gellegher, AlSmith, K [Kewns, 27 su 28 Mo 29 Tu |30 We |31 Th |1 February |2 Sa
6:00 pm - 7:30 am .
labor day labor night labor day
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V1. Print Preview Options for Calendars and Tables from Amion.com

There are also numerous printing options within the Print Preview feature at Amion.com. In the
below example (figure 17), the page is set to landscape and the print size is 150%.

Landscape Page Turn On/Off Chg.
/Portrait Setup Headers Print Size

Figure 17 — Amion.com Print Preview

&l Print P)eview

= [1 Page View v|‘|150%

Schadelz for Emith K, January 2008

EHdh 2 BS e > A amion

2007 Jan Feb Mar Apr Mawv June July Aug Sept O ec 2008 2008

Schedule for Smith, K, January 2008

30 December |31 Mo 1 New year |2 We 3 Th 5 Sa

labor dav labor night

& January & Tu 10 Th 12 Sa

EDR labor night labor night TNC

13 Su 15 T 17 Th

TNC TNC

21 MLE day ‘@[22 Tu 25 Fr

labor night EDR EDR

28 Mo 29 Tu 30 We 1 February |2 Sa

labor night labor dav
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